NML - Master Oscillator

This document presents a general description of the design and performance of the master oscillator for the New Muon Laboratory (NML) International Linear Collider Test Area (ILCTA).

Table of content

1. Requirements
   a. List of clients
   b. List of frequencies with power levels
   c. List phase noise specifications
   d. Summary table

2. Block diagram
   a. Simplified block diagram
   b. General description
   c. List of referenced schematics

3. Design: subsystems
   a. 10 MHz reference with electrical and mechanical tuner
   b. Clock configuration circuit board
   c. Phase lock loop filter
   d. Power supply

4. Performance
   a. RF output spectrums
   b. RF output phase noise measurements
   c. Study about isolation from microphonics
1. Requirements
   a. List of clients

   The master oscillator clients are listed below:
   - Laser / beam source
   - Reference line distribution system
   - RF stations
   - Timing systems
   - Instrumentation
   - LO distribution line system
   - Monitor systems

   b. List of frequencies with power level

   The master oscillator frequencies are listed below, with the corresponding clients:
   - 1313 MHz local oscillator reference
     - LO distribution system
     - RF receivers
     - RF transmitter
     - MFC controller clock
   - 1300 MHz RF reference
     - RF reference distribution line system
     - RF receivers reference channel
     - Instrumentation
   - 81.25 MHz laser reference
     - Laser system
   - 52.00 MHz piezo system LO
     - Piezo cavity resonance control system
   - 50.00 MHz ESECON clock
     - VME ESECON controller clock
   - 9.027 MHz timing clock system NML-CLOCK
     - VXI Timing reference clock

   c. List of phase noise specifications

   - Phase noise
     - 1313 MHZ
     - 1300 MHz
     - 81.25 MHz
     - 52.00 MHz
     - 50 MHz
     - 9.025 MHz
• Signal levels
  o 1313 MHz +10 dBm
  o 1300 MHz +10 dBm
  o 81.25 MHz LDVS
  o 52.00 MHz 0 dBm
  o 50.00 MHz CMOS
  o 9.027 MHz TTL

• Phase accuracy and stability
  o RF station to RF station: 0.3° @ 1.3 GHz
  o Laser to 1st RF station: 0.2° @ 1.3 GHz

• The 0° phase reference point for 1300 MHz is the main 1300 MHz RF output on the master oscillator.

d. Summary table

All specifications are summarized in the table below

<table>
<thead>
<tr>
<th>Frequency</th>
<th>Description</th>
<th>Clients</th>
<th>Power level</th>
<th>Phase noise</th>
</tr>
</thead>
<tbody>
<tr>
<td>1313 MHz</td>
<td>LO reference</td>
<td>LO distribution system RF receivers RF transmitter MFC controller clock</td>
<td>+10 dBm +10 dBm +10 dBm 0 dBm</td>
<td></td>
</tr>
<tr>
<td>1300 MHz</td>
<td>RF reference</td>
<td>RF distribution system RF receivers Instrumentation</td>
<td>+10 dBm +10 dBm 0 dBm</td>
<td></td>
</tr>
<tr>
<td>81.25 MHz</td>
<td>Laser reference</td>
<td>Laser</td>
<td></td>
<td>LVDS</td>
</tr>
<tr>
<td>52.00 MHz</td>
<td>Piezo system LO</td>
<td>Cavity resonance control</td>
<td></td>
<td>0 dBm</td>
</tr>
<tr>
<td>50.00 MHz</td>
<td>ESECON clock</td>
<td>ESECON controller clock</td>
<td></td>
<td>LVCMOS</td>
</tr>
<tr>
<td>13.00 MHz</td>
<td>IF reference</td>
<td>Monitor system</td>
<td></td>
<td>0 dBm</td>
</tr>
<tr>
<td>10.00 MHz</td>
<td>Crystal reference</td>
<td>Monitor system</td>
<td></td>
<td>0 dBm</td>
</tr>
<tr>
<td>9.027 MHz</td>
<td>Timing reference</td>
<td>Timing system</td>
<td></td>
<td>TTL</td>
</tr>
</tbody>
</table>
2. **Block diagram**
   a. **Simplified block diagram**

   The following block diagram shows the different subsystems of the master oscillator.

   ![Block Diagram](Image)

   **b. General description**

   The 1.3 GHz Dielectric Resonance Oscillator (DRO) is phase locked loop to the stable 10 MHz reference crystal. The 1.3 GHz is sent to the RF reference line system and brought back to the PLL from the end of the reference line, hence keeping a constant phase reference signal at the input of the divider block. All subsequent signals are divided down from the main 1.3 GHz reference inside the divider block. The local oscillator (LO) signal is generated by mixing the locked 1.3 GHz signal with a sub-harmonic intermediate frequency (IF) of 13 MHz, producing the 1313 MHz after filtering of the upper side band.

   **c. List of referenced schematics**

   More detailed schematics of the master oscillator subsystems are found here:

   Y:\Projects\LLRF\Systems\NML\Documentation\Master Oscillator\
3. Design: subsystems

a. 10 MHz reference with electrical and mechanical tuner

Description:

A voltage control oscillator provides a 10 MHz reference signal. This frequency can be adjusted mechanically and electrically.

Key features:

- Stable 10 MHz reference
- +12 dBm output level
- +/- 15VDC supply
- +/- 14 Hz mechanical tuning range
- +/- 3 Hz electrical tuning range
- RF tight casing
- Vibration proof support
- Electrical tuning monitor point
- Additional input to provide external electrical tuning

Block diagram:

Description of interface:
Inputs:
- +/- 15 VDC power supply
- External (5K) potentiometer 10 turns with lock for electrical tuning
- extra high impedance input (BNC) for electrical tuning
- opening in the casing for mechanical tuning

Outputs:
- 10 MHz RF main output (SMA)
- 10 MHz RF monitor output (SMA)
- Tuning voltage monitor point

Specifications:

<table>
<thead>
<tr>
<th>Power Supply</th>
<th>nominal</th>
<th>units</th>
</tr>
</thead>
<tbody>
<tr>
<td>+15 V</td>
<td></td>
<td>V</td>
</tr>
<tr>
<td>400 mA</td>
<td></td>
<td>mA</td>
</tr>
<tr>
<td>240 mA</td>
<td></td>
<td>mA</td>
</tr>
<tr>
<td>-15 V</td>
<td></td>
<td>V</td>
</tr>
<tr>
<td>11 mA</td>
<td></td>
<td>mA</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Electrical tuning</th>
<th>range</th>
<th>sensitivity</th>
</tr>
</thead>
<tbody>
<tr>
<td>+/- 5 V</td>
<td>+/- 2 x 10^{-7} ppm</td>
<td></td>
</tr>
<tr>
<td>+/- 3 Hz</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Mechanical tuning</th>
<th>sensitivity</th>
<th>range</th>
</tr>
</thead>
<tbody>
<tr>
<td>+/- 1 x 10^{-6} ppm</td>
<td>+/- 14 Hz</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Outputs</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Main RF output level</td>
<td>+13 dBm</td>
<td></td>
</tr>
<tr>
<td>RF monitor</td>
<td>-10 dBm</td>
<td></td>
</tr>
</tbody>
</table>
Measurements:

Testing Crystal serial # 14075-0545
Electrical tuning range: 6 Hz

Using frequency counter: 9,999,995.062 Hz – 10,000,001.073 Hz

Notes:

Related documents:

Tuneable 10MHz Reference.pdf

C:\My documents\CC2\Master Oscillator\10 MHz crystal VCO\schematic\
b. **Clock configuration circuit board**

**Description:**

This board configures the clock chip of the AD9510 evaluation board. The configuration is performed by a PIC microcontroller. This configuration board is connected to the evaluation through a 26 pin header. The board gets its power from the AD9510 evaluation board. The programming is done using the chip serial port. The board has a LED indicating when the programming is done. An output header is reserved for another LED indicating when the clock is locked to the reference signal.

**Key features:**

- Gets power from evaluation board
- Programming done LED indicator
- PLL locked LED indicator
- Programs directly upon boot up

**Block diagram:**

![Block Diagram](image)
Description of interface:

Inputs (through the 26 pin header):
- SDIO, pin 2 (serial I/O, not currently used)
- SCLK, pin 4 (serial clock, used to clock the serial communication)
- CSB, pin 6 (chip select bar, used to gate individual communication cycles)
- SDO, pin 8 (serial output, used to write configuration to the clock)
- Status, pin 10 (soft tied to PLL status, un/locked, connected to output LED)
- Function, pin 12 (not currently used)
- VDD, pin 16, 3.3VDC from AD9510 eval board

Outputs:
- LED indicator for end of programming (on board)
- 2 pin header for front panel LED to indicate PLL lock status

Specifications:

<table>
<thead>
<tr>
<th>Power Supply</th>
<th>+3.3 VDC</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>&lt;200 mA</td>
</tr>
</tbody>
</table>

Related files:
- PIC board_sch.pdf    schematic of the clock configuration board
- PIC board_layout.pdf silk screen layout of the clock configuration board
- PIC12f675.pdf        documentation for the PIC microcontroller
c. **Phase lock loop filter**

This section presents the design and measurements for the loop filter used in the phase lock loop.

**Features:**
- low pass filtering of the charge pump current output of the PLL
- maximum voltage swing to optimize control of the DRO
- option to inject noise externally into the loop for noise analysis
- control voltage buffered monitor point available

**Specifications:**
- Loop bandwidth: 500 Hz
- Phase margin: 70°
- Active filter design

**Schematics:**

Loop filter section:

![Loop filter schematic diagram](image-url)
Voltage reference section:

Monitor point section:
Power regulation section:

![Power regulation diagram]

Design description:

**Design using ADIsimCLK:**

C:\My documents\CC2\Master Oscillator\ADIsimCLK\loop filter\filter_5.clk

**Specifications:**

- Loop bandwidth \( \sim 500 \text{ Hz} \)
- Phase margin \( \sim 70 \text{ deg} \)
- Active filter design, 2 poles 1 zeros, with an OP27

![Active filter circuit diagram]

The first pole \((R_1,C_1)\) and the second poles \((R_3,C_3)\) are at 4.8 kHz, the zero is \((R_2,C_2)\) is at 68 Hz. The DC gain is \( G = \frac{R_2}{R_1} = -480 \)

In an alternate design, the values \( R_1 \) and \( C_1 \) are changed to \( R_1=10k \) and \( C_1=3.3nF \). The pole remains the same, but the low frequency gain is dropped to \( G=4.8 \)

The reference voltage \( V_{ref} \) is given by the low noise voltage reference chip ADR440B, providing 2.048V. A voltage divider 5K,14K brings the reference voltage down to 1.5V
Noise analysis:

**PSpice simulation: (design#5)**
C:\Documents and Settings\branlard\My Documents\CC2\Master oscillator\PLL loop filter\PSpice

Schematic:

![Schematic diagram](image)

Transfer function:

![Transfer function graph](image)
**Measured transfer function:**
C:\Documents and Settings\branlard\My Documents\CC2\Master oscillator\PLL loop filter\design#5

![Graph showing transfer function measurement](image)

To measure the transfer function using the low frequency vector analyzer, a series resistor of 1 Mohm was put in parallel with the capacitor of the op amp feedback loop, to allow for DC current feedback. A DC block was also put in series with the analyzer’s source and a 1 Mohm series resistor to make the source look like a current source.

**Measurement setup:**

**Instrument setup:**

*Display setup:*
- Measure groups → Swept sine
- Measurement → Transfer function

*Freq:*
- Start → 1 Hz
- Stop → 10 kHz
- Type → log
- # points → 200

*Display options:*
- Format → Dual
- Active display to toggle between top and bottom

*Display setup (active A ; active B):*
- View → Log Mag
- View → Phase
Interpretation of the two plots:

Looking at the phase, we can see the first pole around 3Hz. This is due to the 1 Mohm resistor in parallel with the 0.049uF capacitor. The first zero appears around 70 Hz. It is due to the 48k resistor in series with the 0.049uF capacitor. Then the second pole appears around 4.8kHz, it is due to the 100 ohms with the 0.33uF capacitor. These features are observed on both plots. The phase scale is off by 180 degrees comparing the simulation and the measured data. This is probably do to the fact that the gain is actually negative (sign inversion). Looking at the amplitude plot, we also observe the 2 poles and the zero at similar frequency values. The difference in gain can be accounted for by the fact that in the measurement, a 1 Mohm resistor is placed in series at the CP input to emulate the current source behavior of the charge pump. This decreases the DC gain by roughly $10^6$ or 120 dB.

Notes:

Related documents:
Schematic and PCB layout:
- PLL bot.pdf
- PLL top.pdf
- PLL Loop Filter.pdf
- PLL Loop FilterPCB.pdf
C:\Documents and Settings\branlard\My Documents\CC2\Master oscillator\PLL loop filter\Board layout
Components:

**DRO:**

**Sensitivity:** DRO_sensitivity.xls in C:\Documents and Settings\branlard\My Documents\CC2\Master oscillator\DRO

<table>
<thead>
<tr>
<th>VCO [V]</th>
<th>Frequency [Hz]</th>
<th>Linear fit [Hz]</th>
</tr>
</thead>
<tbody>
<tr>
<td>-10</td>
<td>1,299,985,445</td>
<td>1,299,983,692</td>
</tr>
<tr>
<td>-9</td>
<td>1,299,986,790</td>
<td>1,299,985,506</td>
</tr>
<tr>
<td>-8</td>
<td>1,299,988,230</td>
<td>1,299,987,320</td>
</tr>
<tr>
<td>-7</td>
<td>1,299,989,090</td>
<td>1,299,989,133</td>
</tr>
<tr>
<td>-6</td>
<td>1,299,991,090</td>
<td>1,299,990,947</td>
</tr>
<tr>
<td>-5</td>
<td>1,299,992,590</td>
<td>1,299,992,761</td>
</tr>
<tr>
<td>-4</td>
<td>1,299,994,012</td>
<td>1,299,994,575</td>
</tr>
<tr>
<td>-3</td>
<td>1,299,995,697</td>
<td>1,299,996,389</td>
</tr>
<tr>
<td>-2</td>
<td>1,299,997,367</td>
<td>1,299,998,202</td>
</tr>
<tr>
<td>-1</td>
<td>1,300,000,016</td>
<td></td>
</tr>
<tr>
<td>0</td>
<td>1,300,000,869</td>
<td>1,300,001,830</td>
</tr>
<tr>
<td>1</td>
<td>1,300,002,674</td>
<td>1,300,003,644</td>
</tr>
<tr>
<td>2</td>
<td>1,300,004,487</td>
<td>1,300,005,458</td>
</tr>
<tr>
<td>3</td>
<td>1,300,006,377</td>
<td>1,300,007,272</td>
</tr>
<tr>
<td>4</td>
<td>1,300,008,438</td>
<td>1,300,009,085</td>
</tr>
<tr>
<td>5</td>
<td>1,300,010,458</td>
<td>1,300,010,999</td>
</tr>
<tr>
<td>6</td>
<td>1,300,012,484</td>
<td>1,300,012,713</td>
</tr>
<tr>
<td>7</td>
<td>1,300,014,604</td>
<td>1,300,014,527</td>
</tr>
<tr>
<td>8</td>
<td>1,300,017,000</td>
<td>1,300,016,341</td>
</tr>
<tr>
<td>9</td>
<td>1,300,019,560</td>
<td>1,300,018,154</td>
</tr>
<tr>
<td>10</td>
<td>1,300,022,200</td>
<td>1,300,019,968</td>
</tr>
</tbody>
</table>

\[ K_v = 1,814 \text{ Hz/V} \]

\[ \text{Offset} = 1,300,001,830 \text{ Hz} \]
**Narrow band spectrum:** SCREN411.GIF in C:\Documents and Settings\branlard\My Documents\CC2\Master oscillator\DRO

![Narrow band spectrum](image)

**Phase noise:** SCREN412.GIF in C:\Documents and Settings\branlard\My Documents\CC2\Master oscillator\DRO

![Phase noise](image)

Phase noise values entered in ADIsimCLK for simulation.

Last Saved: 6/30/2010 by Julien Branlard
Location: Y:\Projects\LLRF\Systems\NML\Documentation\Master Oscillator\NML - Master Oscillator.docx
Expected closed loop gain and phase (ADIsimCLK)
Expected phase noise at 1.3 GHz (ADIsimCLK)

**COMPONENTS: 10 MHz reference:**

Phase noise: (ADIsimCLK)

**d. Power supply**
The master oscillator has the following power consumption:
- +15 VDC, 1.5 Amp
- -15 VDC, 0.5 Amp
- +5VDC, 2.5 Amp

An external power supply was design to cover these needs, along with providing power for 2 up/down converters (each requiring +6VDC, 1.7 Amp and -6VDC, 0.5 Amp). Placing the power supply in an external chassis proved to be an efficient way to isolate the DRO from the line harmonics as illustrated in the 2 plots below:

Power supply in the master oscillator chassis:

![Power supply in the master oscillator chassis](image1)

Power supply in an external chassis:

![Power supply in an external chassis](image2)

The complete power supply schematic can be found at this location:

Y:\Projects\LLRF\Systems\NML\Documentation\Master Oscillator\
4. Performance
   a. RF output spectrums

   **1300 MHz**

   - RF output spectrum
   - Phase noise and integrated jitter

   **1313 MHz**

   - RF output spectrum
   - Phase noise and integrated jitter

   Carrier Power: 6.82 dBm
   Attenuation: 18.00 dB
   Ref.: 50.00 kHz/Hz
   Mtr: 1
   9.9000 kHz
   10.000 kHz

   Carrier Power: 21.92 dBm
   Attenuation: 32.00 dB
   Ref.: 50.00 kHz/Hz
   Mtr: 1
   9.9000 kHz
   10.000 kHz

   Marker Trace Type X Axis Value
   1 SPK 0.59 Hz -73.49 kHz
   2 SPK 0.59 Hz -55.72 kHz
   3 SPK 0.59 Hz -42.60 kHz
   4 SPK 0.59 Hz -31.94 kHz
   5 SPK 0.59 Hz -23.20 kHz
   6 SPK 0.59 Hz -18.70 kHz

   Marker Trace Type X Axis Value
   1 SPK 0.59 Hz -73.49 kHz
   2 SPK 0.59 Hz -55.72 kHz
   3 SPK 0.59 Hz -42.60 kHz
   4 SPK 0.59 Hz -31.94 kHz
   5 SPK 0.59 Hz -23.20 kHz
   6 SPK 0.59 Hz -18.70 kHz
b. **RF phase noise measurements**

To perform an absolute phase analysis measurement, the following setup is used:

![RF phase noise measurement setup diagram]

The plot below shows the phase noise spectrum for 1.3 GHz, 325 MHz and 81.25 MHz:

![Phase noise spectrum plot]

- **1.3 GHz**: 69.3 fs (0.0324°)
- **325 MHz**: 72 fs (0.0084°)
- **81.25 MHz**: 120.8 fs (0.0035°)
c. **Study about isolation from microphonics**

A mechanical analysis on the effect of microphonics vibrations on the master oscillator has been carried through and is reported in this document:

Beams-doc-3634:

Some of the findings are summarized below.

![Graph showing the 1.3 GHz signal with the microphonic stimulus ON and OFF:](image1)

**Marker**: 71.0 Hz, -66.206 dB

**Plot showing the 1.3 GHz signal with the microphonic stimulus ON and OFF:**

![Graph showing the benefit of mounting the DRO on shock absorbing screws:](image2)

**Benefit of mounting the DRO on shock absorbing screws:**
Comparative test between different shock absorbing screws: